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What is Analysis?

Analysis is the tool that allows us to access the Business Warehouse (BW) reports. BW is a data
storage and reporting software that consists of various reports from data in SAP.

There are four functional areas of Analysis — BW to report:

o

Finance

o

Sponsored Projects

o

Supply Chain

o

Human Resources



Analysis - BW Security and Roles

What roles do | need?

The SMART application is a tool designed to help employees identify appropriate roles for their positions
based on an Interactive Interview process or a Role Explanation Lookup. Refer to the following link to access
SMART:

http://webapps.jhu.edu/smart/

How do we add roles?

Roles are assigned to users via ZSR. Most departments have ZSR Initiators to add and/or delete roles. For
information about ZSR, refer to the following link:

http://www.sapathopkins.org/support/sap-security-and-workflow/how-do-i-get-access/adding-and-removing-roles/#1

Helpful Tip: You can view your role assignment in ECC by using
transaction code: ZZWF_SU01D

1. Enter ZZWF_SUO1D in the transaction box

2. Enter your JHED ID

3. Execute (select glasses)



http://webapps.jhu.edu/smart/
http://www.sapathopkins.org/support/sap-security-and-workflow/how-do-i-get-access/adding-and-removing-roles/%231

Getting Started

»Log into SAP

» Click on your SAP JH icon on your desktop OR

» Open your internet browser and go to:
https://sap.erp.johnshopkins.edu/irj/portal

»Log in with your JHED ID and Password


https://sap.erp.johnshopkins.edu/irj/portal

Accessing BW Reports in Analysis

» Access Enterprise Reporting from your SAP NetWeaver Portal.

» Click on the Enterprise Reporting tab.
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Accessing Analysis - Welcome Page

Welcome Jessica Newton JOHNS HOPKINS Help | Log off

UNIVERSITY & MEDICINE

The Enterprise Reporting Welcome Page consists of: =

BW Reports 1 El

o SAP BW News — Display information on Daily/Special
Loads, News, and System Requirements. SAP BW NEWS DAILY LOADS

o BW Reports — Click Open Analysis to access reports
o Documentation — Provides links to training information

and user guides for JHHS and JHU. Da||y Loads
o Notifications — Alerts users of changes, updates, tips,
Monday, October 5, 2015

and tricks in Analysis.

o Arch ives — O rga n izes SA P BW N ews by M o) nt h an d Yea r. Please NOte: The BusinessObjects production system (including Analysis) will be _
taken offline on Friday October 9, 2015 at 5:00 PM for planned maintenance. The DOCUMENTATION
o Sea rch Posts — AIIOWS users to perfo rm free text svstemn will be returned on Sundav October 11. 2015 at 8:00 AM. Access to BW

searches



Navigation Pane - Drilldown & Search

Reports are accessible through:

SAD4

) . . Home | Documents
e Drilldown navigation —OR- -
e Search Feature o
Start by.selectlng from the B £ pusge o
four main menu categories N —
by clicking the “+” symbol or Bl B e
by double clicking the / 5 B2 e oo
category name. B 5] sponsored Projects

! Supply Chain

- [0 310 Finance

Type all or part of the report name in
the Search Box that populates when
you select “Search”




Folders - Drilldown Navigation

As an example, select the “Concurrent SAD4
Assignments” report: [Fiome | Docamerts
. View = Mew Organize = Send Maore Actions = | Details
Select the following path: e — — -

Folders

» Enterprise SAP BW = bl Foders

2 =[] Enperprise 547 BW

AAP Waorkforce Actions Ar

AAP Waorkforce Distribution Ar

Compensation and Hours Ar

> H uman Reso urces " E mnance Compensation Data Elements by Org Unit/Position Ar
>Personnel Admin > 53 Huran Resources Compensation Data lemens Report -

- i3 Serfite Compensation Report Ar

Concurrent Assignment

>Concurrent Assighment - {
Ar

Department Dashboard - Mationality Demographics | Ar
Department Dashboard-Age Demographics Ar
Department Dashboard-Demographics JHHS Ar

[ organizational Management

. . , - -
*Note: Reports are listed in alphabetical order Payrall Ad

}' " [ Persannd Admin

Department Dashboard-Demographics JHU Ar

Department Report by Degree Ar
EEQ Report JHHS Ar

~ Time Management

B Sponsored Projects

B Supply Chain

EEQ Report JHU Ar

% B JHU Finance

AN T Al 9, Al T ’E?ETJ,E'.’I! TN A i 7. 3

Employse Actions Report Ar



Navigation Pane - Search Feature

As an example, search for
“Concurrent Assignments”

report.

Type all or part of
the report name in
the Search Box and
click the magnifying
glass.

I-hmanﬂ.lmenls

SAD4

Last & Months (1)

The Search Results
window will display all
matches found. Double
Click on the report you
want to see.

View Mew Organize Send More Actions Detailz
My Documents Search Results
f‘ﬂﬂv . 5: Concurrent Assignment ——
Search R
Enterprize SAP BW/Human Resources/Personnel Admin
| Cancurrent Assignments | Qi
— 4 | Spedial OT/Work Bonus Detail Cost Assignment
Fiefine Search Resuls Byt
Enterprise SAP BW/Human Resources/Payroll Admin
Q sponsored summary of Gross Salary
analysis workspace (4)
This report displays salary expenses for employees assigned to sponsored programs.
location JHU FinancefAnalysiz Report Templates/Recondiliation/Sponsored
jhu finance (2
Jenta'prise sgp}bw (2 5 | control Salary Summary of Gross Salary
Shows salary expenses by wage type not assigned to sponsored programs.
Al (3) JHU FinancefAnalysis Report Templates/Recondliation/Payroll
4
Last Year (4)




Prompts Overview

Once you select the report from the navigation pane, the Prompts screen will appear.

Click on the Display
Member Selector
button to select

- available options.

After populating the required
fields, click Validate to check
prompt values for validity. Once

* €3 ZPA_M10_Q0004 [SAP Business

| Area (UN* andfor HS*)

! =@ Personnel Area (UN* and/or HS*) : [ Include - valuas%}
validity is confirmed, red ‘x” will o ———— [Sclcta vete K *
. — o - = * Key Date
change into a green check. Dot Source: 29 o | * © Personnel Ares(selection option, Requree) : || L o
[& ion Option, Optiona H
] Organizational Unit (Multiple Single, Optional] | ~ ~ Employment Status (Required) ( / Click on the dro P down
Click here to connectto. | = €3 E Group ( ion Option, datory ‘ Include - | values ‘ Equal - | 1
source. arrow to select options
= E by (Opti T | ‘ No values selected | IE . _p
Employee (Selecton, Opional) : e to define the variable.
‘ Include - | values ‘ Equal h |
‘ No values selected | E

» Personnzl Subarea (Selection Option, Cpticnal)
b Ornganizational Unit {Multiple Single, Optional)
- * Employee Group (Selection Option, Mandatory)

If you want to save the report as

£ it dinclude th }mude I wies [ Eaa - After populating the required
a a VO rl e a n I n c U e e No values selectsd X |4 . .
e fields, the “OK” button will

variables you have selected, click
Save prompt values with
workplace check box.

£ 2 [ Sveores Ceecion Qpmore) now become active. Select OK
e ( to run report.
| validate ||




The report will populate in the same tab.

Home | Documernts | Concurrent Assignment 7 = &
Rg.- @8- 13- 18- |
o e B bE X (|

= IF ¥ %-

Tip

To make any changes to the variables used to run the report, click the Prompts button in the Data section.
This is the only way to keep the current variables and allow for easy changes. This can allow you to be
more specific in the variables section. The smaller the query, the quicker the response time.



Prompt Screen Tips

»Start out small
» Enter one or two employees’ personnel number

» Limit the Personnel Area or Organizational Unit
»When possible, limit reports to one pay period for faster response.
» Date formats vary, use the drop down key to select the date when possible.

> If you need to add an additional variable for the same field (i.e. multiple employees) click the
Add button or list multiple variables using a semi-colon to separate.

* Employes
| Include - | values | Equal - | - OR
(2o B K |
» Employee
Include - | values | Equal -
1001;1002;1003 |[=]




Analysis Report Navigation

There are a variety of navigation bars and tabs within Analysis reports.

. | |

Home | Documents | Employee Master Dat... F-BEBl
DEQ-|Hv|Ev|é-S Analvze|/lnsert|/D.isplay| @

0 o | B @ X ™ Filter - 90 cort - [E Calculations - Sy Conditional Formatting - | .i—'nutol.rpdatel

’—" 2344 rows by 6 columns, 14064 cells (1 ¥
= | < JE Q]Prumpts Key Figures
‘ﬁq ZPA_1507_Q4001 [SAP Business Warehouse] Position Organizational Unit Hourly Pay Rate JHLLS.
[E ‘
Navigation tabs — Top, left corner | Explanation
The Home tab will take you to the Analysis Inbox. It will also take you to your recently view
documents.
The Documents tab will take you back to the BW Report folders and allow you to run additional

reports in new tabs, while you still keep your current report.

The report you are in will be named in the tab and will be noted in white. There are three icons.
The first is to Open in a new window. The second icon is to Pin this tab or Unpin this tab.
Pinning the report will keep the tab on your Analysis each time you open it. The third icon is to
Close this tab.

]Enmluvaenasternat... = E:3]_




Analysis Report Navigation Cont.

Other Important Navigation Icons Explanation

Save Save a report as a favorite. Use the dropdown and select Save As. The report will save in your
& - Favorites folder and you have the ability to rename it. You can also add additional folders if you
want to organize your favorites.

Send To Send the report. Use this option if you want someone to open the report in Analysis. They will
need the proper security to access it this way. This option sends reports to the SAP
BusinessObjects Inbox. This will be sent to their Analysis Inbox. They will not receive an Outlook
notification. The second and third options to Email and Document Link are not available.

Export to Excel Export data. The default if you click the button is to Excel. If you are sending to Excel, the best
2. practice is to click the Repeat outer header members and Export Key and Text values as separate
columns check boxes and click OK. This will open an Excel document and allow you to save from
there. The dropdown also gives the option of exporting to PDF.

Tabs across report Explanation

~ Analyze L Analyze is the default tab. You can filter or sort the data. You can add calculations or setup conditional formatting to highlight certain
data.

Insert |
The Insert tab will allow you to chart the data. This is best with small amounts of data.

Display |
== The Display tab will allow you to change the display of your report. For example, you could swap the data on the axes, hide nulls and

zeroes, move totals to the top of the data, change the format of the data to a percentage, and compact a hierarchy.



Adding Data to a Report

To create conditions on
Key Figures, filter by
Member or by Measure.

To add pieces of data,
find the data on the left
hand bar and drag and
drop it where you want it
in the rows and columns
layout section.

R

D& d. 2. &.-5

_/Analvze|/lnsert|/D|'splay|

(o e Bk B X |E

7 Bilter - 20 Sort - [E] Calculations - o Conditic

Data -
4 D prompts

]G]

s Daily Working Hours
o Weekly Working Hours
s Monthly Working Hours
s Annual Working Hours
¥ Additional Time ID
1 Country Grouping
W County
Current Supervisor
Date of Birth
74 DSM Code
EEQ Job Category
-

# =

(220l )
:
& f.b"\\

1 Employes

ZPA_IS07_Q4001 [SAP Business Warshouse] ” Key Figures
Ar\ i i & | i
\ S R p— ~
B, Key Figures | =
) = Rows
" Hourly Pay Rate
4 PACE Hourly Rate ,' Employee
” .
#u JHU Semi-Monthhy/HS Bi-Weekly K |o-n ) )
£, Annual Salary ‘f Orgalnlzatlonal Unit
# Em e Groy|
“u Annual Salary FTE Peve ;
“F Next Review Date
s Actual Salary “
# Employment Status
. Appointed Salary
. Employment Percent
.
el
el
ol

“* Background

/l report.

Fields listed under
Columns and Rows
are currently
displayed on the

Tip
To add several pieces of data at one time, first click the

B button in the top right corner. This will prevent
the changes from being incorporated until you click the

button again. This is beneficial to save processing time by
having all changes processed at once instead of waiting
for each one to be processed before you make another
change.




Adding Employee Attributes

Drilling down by Employee allows you to add and display —?E-?nplw_ee' ﬁ
characteristics that are not found in the available data. It is N ”’*‘T::::ES —
important to note that: 4o Addrece Ling 2

o Employee Attributes are as of today — not time dependent % Admin Group for HR

“% Annual Salary
“% Bargaining Unit Entry Date

° You can not filter by Employee Attributes — for display only

% BW System
Example: # Cap.Utilization Lyl
% Challengs Date
» The Hours Worked report does not list employee address or # Challenge Indicator
current supervisor in the available data in the Data pane. 74 Company code
% Contract Type
» This information is in the Employee Attributes and can be % Control Salary Cost

# Controlling area
“ Controlling &Area of Salary Error

displayed on the report by drilling down:

Employee = Attributes = Drag and drop desired fields :CCZ::E -
into the Rows section in the Layout pane. A Currency

| # current supervisor |




Filter Data in Reports

Report data can be filtered to only show necessary information.

» After the report is run, to filter data:

1.
2.

Double click on the name of the data you want to filter in the Layout section.

A Filter section will populate on the left hand side. Deselect the Select
Everything check box.

From here, select the items needed directly or run a search.

To search, type a keyword or part of a keyword in the search box. (The search
is case sensitive.)

Click the dropdown for the Find Members binoculars icon and select the Text
option.

Click the Find Members binoculars icon, then select items to filter.
Click OK.

Individual Selection
() Range Selection

| CUSTODIAN

| 5

Member (Key :

[ 20022087 :
[[] 20022375
[[] 20022575 :
[ 20022670 :
[[] 20022671 :
[[] 20022893 :
[[] 20022934 :
[[] 20023028 :
[[] 20023380 :

Medium description)
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN
CUSTODIAN




Use Filter to Exclude Data in Report

Report data can also be filtered to exclude unnecessary information.

» After the report is run, to filter data:

1. Double click on the name of the data you Spieseenel
want to filter in the Layout section. Not Equal To || 30001420 IEl
2. AFilter section will populate on the left hand and:
side.
3. From here, select the Range Selection option Not Eaual To 30077620 - 077620 [X]
4. Select Not Equal To from the dropdown, and
enter the key associated with the item that
you want to exclude.
5. Click Add Range.
6. Repeat Steps 4 and 5 to exclude multiple
items.
7. Click OK. — ok | [cancel]




Tips & Tricks

=Filters that you use again and again can be saved by selecting Save Filter before selecting OK.

Save Filter | ok | |cancel|

=|f the data doesn’t provide both a name and number, and you want both displayed, you can add
the name and the number. Right click on the header that you want to change. Select Display as,
then change the display to Key : Text or Text : Key.

Oversight Unit  Personnel Are

|0";€""z'15ﬂ'I e 3
10000002 : %I Sort y |0 UN10 : Unive
E  Totals 3
Show levels »
Expand o lewvel 2
10000005 : Key
10000006 : Text
- Move to 4 Short description
10000007 - Move before 4 Medium description
1'_0_[.'1_0_0_012 Move after » [
. Swap with 4 Key : Short description i
Attributas e Key : Medium description
| Text : Key |
X Remove |




Additional Resources

»JHHS Analysis Training Documentation

https://sapbwnews.johnshopkins.edu/blog/?page id=350

»JHU Analysis Website

http://finance.jhu.edu/reports guides/analysis/overview.html



https://sapbwnews.johnshopkins.edu/blog/?page_id=350
http://finance.jhu.edu/reports_guides/analysis/overview.html
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